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Webinar Companion Handout 
Microsoft’s One Outlook Strategy 

 

In 2006, Outlook Express, a related but separate product, was replaced by Windows Mail and Calendar with the 

roll out of Windows Vista.  As far back as 2013, it has been rumored that Microsoft would rebrand the built-in 

windows desktop mail application to bring it back under the Outlook umbrella.1  In 2020, news surfaced that 

Microsoft was looking to consolidate its many mail, calendar, and contact apps under “One Outlook,”2 based on 

Outlook on the Web.  

Seeing Double? Outlook on the Web and New Outlook 
Outlook for Windows or New Outlook uses the same codebase or building blocks as Outlook on the Web.  

 

You can use many of the same tips for New Outlook as you use for Outlook for Web.  Where there is a difference 

in these instructions, it will be noted. 

Classic 
Outlook for 
Windows

Outlook on 
the Web

Windows 
Mail and 
Calendar

Outlook for 
Mac

Outlook 
Mobile App
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Use Outlook to Improve Time Management  
Whether you are using Classic Outlook or another version, each version of Outlook includes many features to 

help you implement many common time management techniques.   

You can block off Focus Time on your calendar or use the Timer in Journal3 to track the time you spend on tasks 

in Classic Outlook.  Or use the flag status and importance fields across all versions of Outlook to classify items 

according to urgency and importance4. 

 

If you are using the 1-3-5 Rule to schedule at least one large, three medium, and five small tasks each day, you 

can use Tip #5 to move items from your task list to your calendar.   

Here’s how to classify your tasks: 

• Large tasks: 3-4 hours  

• Medium Tasks: 1-2 hours.  

• Small Tasks: <1 hour. 

Tip #1, Tip #8 and Tip #9, provide additional ways you can use the Eisenhower Matrix (shown above) to manage 

your email by quickly deleting messages, keeping important messages at the top of your inbox, and deferring 

messages that can wait. 

For Time Management tips and techniques, check out our Thriving at Work: Business Skills & Wellness series. 

  

Do

• Urgent

• Important

Defer/Schedule

• Not Urgent

• Important

Delegate

• Urgent

• Not Important

Delete

• Not Urgent

• Not Important

https://www.timedoctor.com/blog/1-3-5-rule/
https://www.eventbrite.com/cc/thriving-at-work-business-skills-wellness-3327249?utm-campaign=social&utm-content=attendeeshare&utm-medium=discovery&utm-term=odclsxcollection&utm-source=cp&aff=odclsxcollection
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Tip #1: Update Quick Actions 
When you are in Outlook, you have several options to quickly act on messages in your inbox.  Quick Actions is 

one option!   

You can update your choices.   

Here’s how: 

1. Go to Settings. 

2. Go to Mail. 

3. Go to Customize Actions. 

4. Check up to 4 options. 

5. Click Save. 

6. Close Settings. 

In Classic Outlook, you can update your Quick Actions by taking the following steps: 

1. Right click on any message.  

2. Select Set Quick Actions… from the contextual menu that appears. 

3. Update up to two Quick Actions in Quick Actions dialog box. 

4. Click OK. 

 

Please note: 

• The Delete option will always appear in your inbox view even if you do not select it.   

• Updating your quick actions may also update the options that appear in your windows notification for 

incoming messages. 

• You are not able to update Quick Actions for Non-Microsoft accounts. 
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Tip #2: Change Keyboard Shortcuts 
If you already use keyboard shortcuts for Gmail, Yahoo!, or Classic Outlook, instead of learning another set of 

shortcuts, you can change your keyboard shortcuts in Outlook on the Web to match the ones you are already 

using. 

Follow these steps: 

1. Go to Settings. 

2. Click General. 

3. Select Accessibility. 

4. On the Accessibility page, under Keyboard Shortcuts select the option you would like to use. 

5. Click Save. 

6. Close Settings. 

 

If you are using New Outlook, your options are limited to Outlook for Windows and Outlook on the Web. 

Once you’ve selected which keyboard shortcuts you’d like to use, you can type the question mark or click to see 

the list of supported shortcuts. Some shortcuts are not exactly the same.  For example, to go to the Mail view, 

the shortcut is CTRL+SHIFT+1 instead of CTRL+1. 
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If you are interested in using keyboard shortcuts with other popular email clients, here are some references to 

investigate: 

• Keyboard Shortcuts for Outlook 

https://support.microsoft.com/en-us/office/keyboard-shortcuts-for-outlook-3cdeb221-7ae5-4c1d-8c1d-

9e63216c1efd 

 

• Keyboard Shortcuts for Gmail 

https://support.google.com/mail/answer/6594?hl=en&co=GENIE.Platform=Desktop 

 

• Keyboard Shortcuts for Yahoo! 

https://d.docs.live.net/291b8c551c3bf9c9/Rainwater Growth/BlogPosts/Keyboard Shortcuts for Yahoo 

 

• Keyboard Shortcuts in Mail on Mac 

https://support.apple.com/guide/mail/keyboard-shortcuts-mlhlb94f262b/mac 

Tip #3: Use Undo Send 
If you have ever hit send and immediately remembered something you forgot to add or saw an error, you can 

use the Undo Send feature to stop a message before it reaches its recipient. 

Here’s how: 

1. Go to Settings 

2. Go to Mail 

3. Go to Compose and Reply 

4. Scroll towards the bottom and update Undo Send. 

5. Click Save. 

6. Close Settings. 

You can also find this feature in Gmail on the General tab of the 

full Settings menu.  In Gmail, you have a cancellation period of 

up to 30 seconds.5 

If you are in Classic Outlook, you can use the Rules Wizard to 

create a rule to defer delivery of all messages for the number of 

minutes that you specify.   

  

https://support.microsoft.com/en-us/office/keyboard-shortcuts-for-outlook-3cdeb221-7ae5-4c1d-8c1d-9e63216c1efd
https://support.microsoft.com/en-us/office/keyboard-shortcuts-for-outlook-3cdeb221-7ae5-4c1d-8c1d-9e63216c1efd
https://support.google.com/mail/answer/6594?hl=en&co=GENIE.Platform=Desktop
https://d.docs.live.net/291b8c551c3bf9c9/Rainwater%20Growth/
https://d.docs.live.net/291b8c551c3bf9c9/Rainwater%20Growth/BlogPosts/Keyboard%20Shortcuts%20for%20Yahoo
https://d.docs.live.net/291b8c551c3bf9c9/Rainwater%20Growth/BlogPosts/Keyboard%20Shortcuts%20for%20Yahoo
https://support.apple.com/guide/mail/keyboard-shortcuts-mlhlb94f262b/mac
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Tip #4: Filter Calendar 
If you have ever struggled to find an invitation sent by someone else or for a specific project, Outlook on the 

Web and New Outlook have a new feature to help you easily filter calendar events. 

You can use Filter Calendar to easily filter your view Category, Sender, and Recurrence. 

Here’s how: 

 

1. Go to Filter on the Home tab of the ribbon. 

 

2. On the dropdown menu, use the checkboxes to select or 

deselect the items by which you would like to filter your 

results. 

In Classic Outlook, with a few more steps you can accomplish 

something similar by using Views.   

For example, to filter by category, you could follow these steps: 

1. Go to the View tab. 

 

2. Go to View Settings. 

 

3. In the Advanced View Settings: Calendar dialog box that 

appears, select Filter... 

 

4. Go to More Choices tab in the Filter dialog box. 

 

5. Click Categories and select the categories you would like to filter for.   

 

6. Click OK twice. 

Repeat similar steps to create other types of filters based on your needs.   

 

You can save the filter for easy reuse by using the Save Current View 

As a New View… option available from Change View button in the 

Current View group.  
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Tip #5: Quickly Schedule Tasks Using My Day 
Add tasks directly to your calendar from the Tasks view of the My Day Task pane. 

• Click and drag the Task to the day and time that you would like to block off your schedule.   

 

• Once you have added the event, you can adjust it to reflect the time you need.  

This feature works best on Day and Week views.  If you use it on the Month view, the task will be added as an 

All-Day event. 

If you are using Classic Outlook, you can achieve similar results when you drag Tasks to the Calendar icon on the 

folder pane in the lower left of your screen.   

 

A new calendar item will appear with the contents of your task.  You can then adjust the date and time. 
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Tip #6: Forward Email as an Attachment 
When forwarding a message to another recipient, you may want to send 

it as an attachment instead of inline text.   

You can forward a message as an attachment by following these steps: 

1. Click the ellipsis icon to get to More Actions.  

 

2. Select Other reply actions. 

 

3. Select Forward as Attachment. 

You can now continue composing your message as planned. 

Tip #7: Use the @ Symbol 
When composing a message, use the @ symbol to mention contacts from your address book to quickly add them 

as addressees. 

Tip #8: Pin Messages 
When we are sorting messages, we can pin messages that require urgent action but cannot be resolved quickly. 

Here’s a couple of ways to do it: 

1. Select a message. 

2. Select Pin from the Tags group of the Home tab of the Ribbon. 

Tip #9: Use Snooze 
The Snooze function in Outlook on the Web or Gmail6 can be used to defer messages 

for later action. 

1. Select your message. 

2. Select Snooze from the toolbar. 

3. Select the time you want the message to reappear.   

If you need to access a message before it makes its scheduled return to your inbox, snoozed messages can be 

found in the Scheduled folder in Outlook and the Snoozed Folder in Gmail. 

For Classic Outlook and other clients without the Snooze or Pin features, you can create tasks or Flag the 

message for future reference.  
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Rainwater Growth, LLC 
Rainwater Growth is your source for quality, affordable training, and research.   Our mission is to provide free 

and low-cost training for individuals, small businesses, and non-profits. 

Check out our website to read our blog to learn and explore sources of free and low-cost training, to invest in 

custom training, or to get a quote for technology research.   

Website: https://www.rainwatergrowth.com 

You can also join our Meetup group, Workshops and Reading, to learn about upcoming free training courses 

from a variety of vendors.   

On our Eventbrite page, you can find out about our upcoming interactive live training classes. 

https://rainwatergrowth.eventbrite.com 

Finally, you can follow us on Flipboard or LinkedIn to catch-up on the latest tech news and tutorials. 

• Flipboard: https://flipboard.com/@RainwaterGrowth  

• LinkedIn: https://www.linkedin.com/company/rainwater-growth-training-and-consulting/ 

 

Additional References 
 

1 Microsoft said to be testing an Outlook client for Windows RT 

2 Microsoft to replace its many mail variants with 'One Outlook'  

3 Track actions in Journal  

4 How to use the Eisenhower matrix to prioritize your work  

5 Send or unsend Gmail messages 

6 Snooze emails until later 

https://www.rainwatergrowth.com/
https://www.meetup.com/workshops-and-reading/
https://rainwatergrowth.eventbrite.com/
https://flipboard.com/@RainwaterGrowth
https://www.linkedin.com/company/rainwater-growth-training-and-consulting/
https://www.zdnet.com/article/microsoft-said-to-be-testing-an-outlook-client-for-windows-rt/
https://www.zdnet.com/home-and-office/work-life/microsoft-to-replace-its-many-mail-variants-with-one-outlook/
https://support.microsoft.com/en-us/office/track-actions-in-journal-31dcbfc2-fafb-4a0d-9396-aee35a9a97fe
https://www.microsoft.com/en-us/microsoft-365-life-hacks/organization/how-to-use-the-eisenhower-matrix
https://support.google.com/mail/answer/2819488?hl=en&co=GENIE.Platform=Desktop
https://support.google.com/mail/answer/7622010

